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by David T. Allison

Introduction

This document explains the purpose and usage of several AutoLISP applications designed by
David Allison for generating diagrams useful in the Earth Sciences. These applications can be
easily modified for other purposes outside of the realm of Earth Science. The specific purpose
and usage of each application is described below, however, there is a certain degree of
modification necessary to the AutoCAD operating environment before they are ready to use.
Each application may call procedures contained in several “libraries” of commonly used
functions. A variable containing the file path to the directory where these files are located must
be defined before one of the applications can be executed.

Installing the Applications

When you download the AutoLISP applications from the web site your are actually downloading
a single compressed file named “DTA_AutoLISP.zip” that contains all of the individual source
code files. Create a folder where you wish for the applications to reside, copy the ZIP file to this
folder, and then double-click on the ZIP file while in file explorer to un-compress and extract the
files to that folder. For example, I keep all of the LISP applications in this folder:

e:\acadmapdata\lisp

For the purposes of this document I will use this path as an example.

If  file explorer does not extract the files you may not have ZIP file capability installed on your
computer. If so, search the web for the keyword “WinZip” or “7-zip” with your web browser
until you locate this utility, and then install it.

The LISP applications described in this document have been tested using AutoCAD 2000.
Different versions of AutoCAD are generally compatible with LISP applications, however, you
may have to modify the setup procedures described below if you are using a different version.
For demonstration purposes I will assume AutoCAD 2000 is installed on the computer. 

When AutoCAD 2000 is started, it looks for a file named “acad2000.lsp” (release 14 looks for
“acadr14.lsp”) and automatically loads and executes the statements in it. For this reason, this file
is an ideal mechanism for initializing the file path variable that will point to files used by the
LISP applications. Use Windows file explorer to search for the “acad2000.lsp” file. When found,
double-click on the file name. This will load the source code into notepad. Add the following
line as the last line in the file:

(Load “c:/acadmapdata/lisp/acadinit.lsp”)
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Of course, you should modify the above file path to match your particular situation. For
example, your primary hard disk drive may be “e:” rather than “c:”. Save the changes to this
“acad2000.lsp” file, and then use the notepad “File > New” menu to clear the screen. We now
need to create the “acadinit.lsp” file. Type the following line:

(setq #LispDir "c:/acadmapdata/lisp/")

Note that AutoLISP uses the forward slash “/” to separate folder names in a file path. The above 
line instructs AutoCAD to save the directory path to the LISP files into a variable named
“#LispDir”. The LISP applications use this variable to find the various library files, therefore, it
must be initialized when AutoCAD starts. Now you should save this file as “acadinit.lsp”, and
save it to the folder indicated in the “acad2000.lsp” file (in this example “c:/acadmapdata/lisp/”).
The next time AutoCAD Map is started the “Acad2000.lsp” file is automatically executed. The
load statement that has been inserted into this file will cause “Acadinit.lsp” to be loaded also,
and that initializes the “#LispDir” variable.

As a test, start AutoCAD and wait for the command prompt. Type the below expression:

command: !#LispDir<enter>

You should see AutoCAD respond with the path entered into the “acadinit.lsp” file:

"c:/acadmapdata/lisp/" {i.e. whatever path you entered into Acadinit.lsp}

You are now ready to run the applications included in this package. If you have trouble setting
up the applications on your system, try contacting me for help.

David Allison
Dept. of Earth Sciences
136 Life Sciences Bld.
University of South Alabama
Mobile AL 36688
phone: (251)460-6381
e-mail: dallison@jaguar1.usouthal.edu

Executing AutoLISP Applications

Starting AutoLISP applications begins with the “Tools > Load Application” menu sequence. The
dialog in Figure 1 displays an example of this dialog with the application “MAPPRO” being
loaded. Note that you must navigate the dialog to the folder containing the LISP application file,



AutoLISP Application Documentation

by David T. Allison

in this case “e:\acadmapdata\lisp\mappro.lsp”. 

Within a LISP application such as “MAPPRO.lsp”, there will be a function definition with a
name prefaced with a “c:”. This adds the application to the AutoCAD 2000 command list. For
example, in the file “Mappro.lsp”, the main application is contained in the function named
“c:mappro”. Because of the “c:” prefix, we can start the program by simply typing at the
command prompt:

command: mappro<enter>

You should now see the application MAPPRO begin to execute. Usually the author of an
AutoLISP application names the file name the same as the command name, but this is not always
the case. If you inspect an application source code (.lsp) with a text editor, and search for “c:”,
you will find the command name. For example, if you searched the file “myapplication.lsp” for
“c:” and found the following line:

(defun c:myapp ( / x y z)
   {do LISP stuff} 
   {do more LISP stuff}
   .
   .
); defun

You would need to type the following to start the application after it had been loaded:

command: myapp<enter>

Note that the “c:” in the function name has absolutely nothing to do with a disk drive. The “c:”
simply tells AutoCAD Map that instead of having to type the LISP expression “(myapp)” to start
the program, you may instead type “myapp” to begin the program.

MAPPRO Application

MAPPRO is an application designed to calculate the projection of geodetic coordinates (latitude
and longitude) into a variety of map coordinate systems based on several map projection
systems. This application has two basic modes: (1) interactive mode where the user types in
geodetic coordinates and receives as output the conversion to a coordinate system (i.e. UTM,
SPCS, etc.), and (2) a file mode where a text data file of sample locations are read line-by-line
and inserted into the current AutoCAD drawing file. File mode typically reads data that is the
result of a database query, and the application will insert geological planar and linear structures
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as oriented symbols into a geologic drawing file. The application can also insert markers that
locate a sample position, and annotate the symbol with the sample I.D. code. The symbols are
inserted as blocks, so the user has full control over the design of the symbols, and their size in
the drawing. 

In interactive mode the user may save the coordinates of projected geodetic values to a series of
variables that can be used in the current session, or saved to disk to be recalled in a later session.
For example, suppose you need to calibrate a 1:24,000 quadrangle into the UTM coordinate
system. The base map does not have UTM grid lines, only the standard blue tic marks on the
border. Therefore, unless you draft the grid yourself, there are no calibration points on the map
where both UTM x and y coordinates are precisely known. In this situation MAPPRO can be
used to calculate and store the UTM coordinates of precisely known geodetic coordinates, for
example, the corners of the quadrangle map border. If MAPPRO is run in interactive mode, and
the user indicates that he or she wishes to store calculations in variables, a series of variables
named pt1, pt2, pt3, etc., will be created containing the x and y values in the same order as
entered. If you type in the geodetic coordinates of the SW corner first, pt1 will contain the
projected coordinates. Whenever you need to refer to those coordinates in an AutoCAD Map
command, simply preface the variable name with the exclamation mark (!).  For example, the
“TABLET > CAL” command could use the point variable values when the coordinates of the
digitized control point are requested. This has the distinct advantage of avoiding the typing of
large UTM coordinate values where typographical errors are easily made. 

MAPPRO uses the following library LISP files:

PROJLIB.LSP- map projection functions
MATHLIB.LSP- common mathematical functions
FILELIB.LSP- file handling functions
STRLIB.LSP-  string handling functions

The MAPPRO program, and the above library files should reside in the subdirectory pointed to
by the “#LispDir”  variable. This variable is normally set in the “acadr14.lsp” or “acad2000.lsp”
file, or a LISP file loaded by “acad2000.lsp” (see discussion of installing the applications above).

Supported map projections include:
Universal Transverse Mercator
Lambert Conformal Conic
Transverse Mercator
Alber's Equal Area
Polyconic
Mercator
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Latitude-Longitude data formats include:
1. Degrees, minutes, and seconds ("DMS") >  ex. "-33 15 30.2"
2. Decimal degrees ("DD") >  ex. "-123.56798"
3. Radians ("R") >  ex. "1.578943"

MAPPRO Example Sessions

Interactive Mode

Load the MAPPRO application using the “Tools > Load Application” menu. Find the
“mappro.lsp” file in the folder where you deposited the downloaded LISP files. Load the file
with the “Load” button in this dialog. Make sure that the “#LispDir” variable points to the
directory containing LISP library files (“ProjLib.lsp”, “FileLib.lsp”, etc.). You can test the
“#LispDir” variable by typing this command at the AutoCAD Map command line:

Command: !#LispDir<ENTER>

“c:/acadmapdata/lisp/” (this is the response by AutoCAD Map)

If the response is “nil”, or points to the incorrect folder, the setup of the “Acad2000.lsp” file is
not correct. You can set the value manually with a LISP expression:

Command: (setq #LispDir “c:/acadmapdata/lisp/”)<ENTER>

However, you should fix any “Acad2000.lsp” setup problems so that the path is correct
whenever AutoCAD Map starts (see above description).

Below is the input and responses of an interactive MAPPRO session. In this session 4 point
variables are set to the UTM coordinates of the corners of a 1:24,000 quadrangle. After this
session the variables pt1, pt2, pt3, and pt4 could be used, for example, to calibrate this map to
the UTM coordinate system using the geodetic corners of the quadrangle map. Note that input
typed by the user is in boldface type. The “<ENTER>” represents the pressing of the “Enter” key
(also known as the “Return” key).

Command: mappro<ENTER>

============================================================================
|                         MAPPRO Utility Program                            |
| Map projection program to plot station locations or structural geology    |
| data upon base maps digitized with one of the supported map projection    |
| coordinate systems.                                                       |
|                                                                           |
|                        Copyright (c) 2001                                 |
|                        by David T. Allison                                |
|                           Dept. of Earth Sciences                         |
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|                           University of South Alabama 36688               |
|                          (251)460-6381                                    |
|                          E-Mail: dallison@jaguar1.usouthal.edu            |
=============================================================================
NOTE: western hemisphere longitude and southern hemisphere latitude
values should be entered as negative in degrees field.
Data will be inserted into the current layer.
The current layer is:0
Change current layer (Y/N) [N]:y 

{Layer dialog window opens here, see Figure 2}
Loading library file: FileLib.lsp
Loading library file: MathLib.lsp
Loading library file: ProjLib.lsp
Loading library file: StrLib.lsp-style Enter name of text style or [?] 
<STANDARD>: Standard
Existing style. Full font name = Arial
Specify full font name or font filename (TTF or SHX) <ARIAL.TTF>: Arial Specify 
height of text <0.0>: 0.0 Specify width factor <1.0>: 1.0
Specify obliquing angle <0d0'>: 0.0 Display text backwards? [Yes/No] <N>: N 
Display text upside-down? [Yes/No] <N>: N
"STANDARD" is now the current text style.
(U)TM, (T)M, (P)olyconic, (C)onformal, (M)ercator, (A)lber's or (N)ull[U]: u<ENTER>

Enter the UTM grid zone [16]: 16<ENTER>

Data in northen or southern hemisphere (N/S) [N]:n<ENTER>

Input geodetic coordinates with latitude first (left-most) (Y/N) [Y]:y<ENTER>

Current angle input format is Decimal degrees.
Change angular input format (Y/N) [N]: y<ENTER>

NOTE: 'DMS'=degrees,minutes,seconds;'DD'=decimal degrees,'R'=radians.
Enter 'DMS', 'DD', or 'R' : dms<ENTER>

Output coordinates in (M)eters or (F)eet [M]: m<ENTER>

Enter relational fraction for map scale (ex. 1:1) [1:1.00]: 1:1<ENTER>

(P)ost data, (I)nteractive session, or (Q)uit[P]: i<ENTER>

Store results to variables (Y/N) [N]:y<ENTER>

{File Create dialog opens at this time, see Figure 3}

Current format is [+/-]DDD MM SS.SS [+/-]DDD MM SS.SS.
Enter latitude and longitude: 32 45 0 -86 22 30<ENTER>

--> X: +558,550.76 Y: +3,623,554.96
Current format is [+/-]DDD MM SS.SS [+/-]DDD MM SS.SS.
Enter latitude and longitude: 32 45 0 -86 15 0<ENTER>

--> X: +570,261.16 Y: +3,623,630.98
Current format is [+/-]DDD MM SS.SS [+/-]DDD MM SS.SS.
Enter latitude and longitude: 32 52 30 -86 22 30<ENTER>

--> X: +558,468.84 Y: +3,637,411.97
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Current format is [+/-]DDD MM SS.SS [+/-]DDD MM SS.SS.
Enter latitude and longitude: 32 52 30 -86 15 0<ENTER>

--> X: +570,162.86 Y: +3,637,488.14
Current format is [+/-]DDD MM SS.SS [+/-]DDD MM SS.SS.
Enter latitude and longitude:<ENTER>

Variables are stored as pt1, pt2, etc., in file: 
E:/ACADMAPDATA/Ala-geo/rc-calib.lsp
Load point variables (Y/N) [Y]:y<ENTER>

Variables are saved in file: E:/Acadmapdata/Ala-geo/RC-geo.lsp
You can now use the point variables in AutoCAD expressions.
Preface a variable such as pt1 with an exclamation mark, for example
[zoom !pt1 !pt4] would zoom window to the coordinates of pt1 and pt4.
You can re-call the point variable definitions by using the LOAD command
and indicating E:/Acadmapdata/Ala-geo/RC-geo.lsp as the LISP file to load. This will
initialize the point variables for the current edit session.
any key continues...<ENTER>

(P)ost data, (I)nteractive session, or (Q)uit[I]: q<ENTER>

Run MAPPRO again (Y/N) [N]: n<ENTER>

Command: !pt1<ENTER>
(558551.0 3.62355e+006)

The last typed command simply recalls the value of point variable #1. At this point the user
could use the 4 point variables to calibrate the map to the UTM coordinate system. Note that the
coordinates of each point entered interactively is stored to disk as a LISP (.lsp) file that may be
loaded at any time. For example, the next time the above map needs to be calibrated to a
digitizer, the file “E:/ACADMAPDATA/Ala-geo/rc-calib.lsp” could be loaded as a LISP
application, at which time the point variables stored in the file (pt1, pt2, etc.) become defined
and usable. 

Point variables, like any LISP variables, persist only through the current session. Therefore, if
you load a different file into the current active window, or shut down AutoCAD Map, the
variables will be undefined.

Post from File Mode

MAPPRO was primarily designed to post large batches of data onto digital base maps.
Furthermore, if the data consists of planar or linear geological structure data, MAPPRO rotates
the structure symbol into the proper attitude and labels the dip/plunge attribute with the proper
value. MAPPRO can also simply post a symbol at a location and label it with an identifier. Most
often, the location and structure data are stored in database or spreadsheet applications such as
Microsoft Access® and Excel®. In this way the user can conveniently construct a database
“query” to collect a subset of the data. For more information please visit the below web sites:
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http://www.usouthal.edu/usa/geography/allison/gy461/gy461_DatabaseCreation.pdf
http://www.usouthal.edu/usa/geography/allison/gy461/GY461_InsertingStructure.pdf

When a query file has been saved as a text file (usually with WordPad), you can then run
MAPPRO in “post from file” mode. Before doing so, however, you should check to make sure
that any block references made by the text file are defined in the current drawing. There are
several ways to do this. Perhaps the best way is to use the template file “Map_Prototype.dwg” 
(included in the download file) to start your file. If you have already begun the base map, save
the template as a regular drawing file (.dwg), and then insert it into the base map. The block
definitions contained in the template will then be available in the current base map drawing.

Below is a session in MAPPRO where the data in the file “RC-S1.TXT” is inserted into the
Richville, Alabama, 1:24,000 scale quadrangle. The text file was created by a query within
Access and the first several lines are listed below:

;Latitude Longitude ATTITUDE Station
32.797278 -86.250444 N  7 E 27 E E610
32.795028 -86.252222 N 43 W 23 W E611
32.792583 -86.256556 N 40 E 45 W E612
32.817361 -86.250361 N 77 E 41 E E614
32.751139 -86.264889 N 24 E 42 E E751
32.845833 -86.262944 N 10 W 50 W R036
32.846667 -86.261417 N 25 W 77 W R042
.
.
.

Note that the first line is a comment line because of the “;” (ignored by MAPPRO), and that the
locations are in decimal degrees latitude (first) and longitude. The attitudes are for S1 foliation
(planar). Below are the prompts and responses for posting this data file onto the digital base map.

Command: mappro<ENTER>

============================================================================
|                         MAPPRO Utility Program                            |
| Map projection program to plot station locations or structural geology    |
| data upon base maps digitized with one of the supported map projection    |
| coordinate systems.                                                       |
|                                                                           |
|                        Copyright (c) 2001                                 |
|                        by David T. Allison                                |
|                           Dept. of Earth Sciences                         |
|                           University of South Alabama 36688               |
|                          (251)460-6381                                    |
|                          E-Mail: dallison@jaguar1.usouthal.edu            |
=============================================================================
NOTE: western hemisphere longitude and southern hemisphere latitude
values should be entered as negative in degrees field.
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Data will be inserted into the current layer.
The current layer is:0
Change current layer (Y/N) [N]:y 

{Layer dialog window opens here, see Figure 2}
Loading library file: FileLib.lsp
Loading library file: MathLib.lsp
Loading library file: ProjLib.lsp
Loading library file: StrLib.lsp-style Enter name of text style or [?] 
<STANDARD>: Standard
Existing style. Full font name = Arial
Specify full font name or font filename (TTF or SHX) <ARIAL.TTF>: Arial Specify 
height of text <0.0>: 0.0 Specify width factor <1.0>: 1.0
Specify obliquing angle <0d0'>: 0.0 Display text backwards? [Yes/No] <N>: N 
Display text upside-down? [Yes/No] <N>: N
"STANDARD" is now the current text style.
(U)TM, (T)M, (P)olyconic, (C)onformal, (M)ercator, (A)lber's or (N)ull[U]: u<ENTER>

Enter the UTM grid zone [16]: 16<ENTER>

Data in northen or southern hemisphere (N/S) [N]:n<ENTER>

Input geodetic coordinates with latitude first (left-most) (Y/N) [Y]:y<ENTER>

Current angle input format is Decimal degrees.
Change angular input format (Y/N) [N]: n<ENTER>

Output coordinates in (M)eters or (F)eet [M]: m<ENTER>

Enter relational fraction for map scale (ex. 1:1) [1:1.00]: 1:1<ENTER>

(P)ost data, (I)nteractive session, or (Q)uit[P]: p<ENTER>

{File select dialog open here, see Figure 4}

Enter the type of data, (S)tation, (P)lanar or (L)inear [S]:p<ENTER>

Enter the default block name to use with this data [ST]:s1<ENTER>

Enter the default block scale factor [50.000]:200<ENTER>

Insert block labels (ID,dip,or plunge) as (A)ttributes or (T)ext [A]:a<ENTER>

Command:
"processing line:1" INSERT Enter block name or [?] <S1>: S1 Specify insertion 
point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]:
Enter X scale factor, specify opposite corner, or [Corner/XYZ] <1>: 
200.0000000000000 Enter Y scale factor <use X scale factor>: 200.0000000000000 
Specify rotation angle <E>: -6.000000000000000
Command:
"processing line:2" INSERT Enter block name or [?] <S1>: S1 Specify insertion 
point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]:
Enter X scale factor, specify opposite corner, or [Corner/XYZ] <1>: 
200.0000000000000 Enter Y scale factor <use X scale factor>: 200.0000000000000 
Specify rotation angle <E>: 79.00000000000000
Command:
"processing line:3" INSERT Enter block name or [?] <S1>: S1 Specify insertion 
point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]:
Enter X scale factor, specify opposite corner, or [Corner/XYZ] <1>: 
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200.0000000000000 Enter Y scale factor <use X scale factor>: 200.0000000000000 
Specify rotation angle <E>: 15.00000000000000
Command:
"processing line:4" INSERT Enter block name or [?] <S1>: S1 Specify insertion 
point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]:
Enter X scale factor, specify opposite corner, or [Corner/XYZ] <1>: 
200.0000000000000 Enter Y scale factor <use X scale factor>: 200.0000000000000 
Specify rotation angle <E>: 155.0000000000000
Command:
.
.
.
{until end of data}

Command: zoom
Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window] <real time>: extents
Command: REGEN Regenerating model.

Command:
(P)ost data, (I)nteractive session, or (Q)uit[P]: q<ENTER>

Run MAPPRO again (Y/N) [N]: n<ENTER>

You should now see the structure symbols appear in the current layer of the drawing. Figure 5
displays a zoomed in view of several of the S1 structure symbols. Note that the structure symbols
are automatically oriented according to the attitude in the input file.

LLGRID Application

The LLGRID application is designed to construct a latitude and longitude grid based on common
map projections (Polyconic, Mercator, etc.). For example, if you need to construct 7.5 minute
quadrangle boundaries over the latitude range of 32 through 34 degrees, and longitude range -86
to -84 degrees, this application can do the job. When active LLGRID will prompt for the
“resolution” of the grid- this controls the segment length of each grid line. In the above example,
if 2.5 minutes is set as the resolution, then each side of each 7.5 minute quadrangle is composed
of a polyline made of 3 segments of 2.5 minutes.

Below is a session with LLGRID. You should first load LLGRID as you would any other LISP
application (see description above for MAPPRO loading):

Command: llgrid<ENTER>
=============================================================================
|                                   LLGRID  UTILITY                         |
|                                                                           |
| Utility program for constructing a latitude-longitude grid system based   |
| upon the supported map projections: 1) Polyconic; 2) Transverse mercator; |
| Universal transverse mercator; 4) Mercator; 5) Alber's equal area; and 5) |
| Lambert conformal conic. All are based on NAD27 map datum.                |
|                                                                           |
|            by: David Allison                   Copyright (c) 2001         |
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|                Dept. of Earth Sciences                                    |
|                University of South Alabama                                |
|                Mobile, AL 36688                                           |
|                E-mail: dallison@jaguar1.usouthal.edu                      |
|                (251)460-6381                                              |
=============================================================================

NOTE: western hemisphere longitudes and southern hemisphere latitudes must
be entered as negative values in the degrees field.
The current layer is:0
Change current layer (Y/N) [N]:y<ENTER>

{Layer dialog window opens here, see Figure 2}
(U)TM, (T)M, (P)olyconic, (C)onformal, (M)ercator, or (A)lber's[U]: u<ENTER>

Enter the UTM grid zone [16]: 16<ENTER>

Data in northen or southern hemisphere (N/S) [N]:n<ENTER>

Output coordinates in (M)eters or (F)eet [M]: m<ENTER>

Enter relational fraction for map scale (ex. 1:1) [1:1.00]: 1:1<ENTER>

Enter the long. spacing in [+/-]DDD MM SS.SS format: 0 7 30<ENTER>

Enter the lat. spacing in [+/-]DDD MM SS.SS format: 0 7 30<ENTER>

Enter the long. resolution in [+/-]DDD MM SS.SS format: 0 2 30<ENTER>

Enter the lat. resolution in [+/-]DDD MM SS.SS format: 0 2 30<ENTER>

Enter the lower left (SW) map corner latitude-longitude.
[+/-]DDD MM SS.SS [+/-]DDD MM SS.SS]:32 0 0 -86 0 0<ENTER>

Enter the upper right (NE) map corner latitude-longitude.
[+/-]DDD MM SS.SS [+/-]DDD MM SS.SS]:34 0 0 -84 0 0<ENTER>

{The application will construct the grid at this time}

The map in Figure 6 displays the latitude and longitude grid constructed by LLGRID with the
above settings. Each segment is not joined, however, they can be joined with the “pedit > join”
command from within AutoCAD Map if so desired.

TRIANGULAR Application

The triangular diagram application “TRIANGULAR” is designed to plot data onto a triangular
type of graph. Included with the downloaded ZIP archive are several template files:

Ternary_Diagram.dwt basic ternary graph background
BarkerRockClass.dwt Barker (1978) igneous rock classification
SedimentClass_Ternary.dwt Folk’s sediment classification (sand-clay-silt)
IUGS_A_P_Q.dwt IUGS felsic rock classification (Alkali feld-
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Plagioclase-Quartz)
IUGS_A_P_F.dwt IUGS felsic rock classification (Alkali feld.-

Plagioclase- Quartz)

The triangular application is designed to work with these templates, so you should start your
drawing with one of these templates. If you have a specific type of triangular diagram that is
required for your data, the “Ternary_Diagram.dwt” template will serve as a start point. You can
easily customize the “Ternary_Diagram.dwt” template file to match your requirements. 

Below is an example of plotting data onto one of the ternary diagrams. The data will be mineral
modes from thin section point counts of felsic igneous rocks, therefore, the IUGS_A_P_Q file is
used as the template. Next, points counts tabulated in an Excel spreadsheet are copy-and-pasted
to a WordPad text file. The file contains:

Mineral modes for GY343 petrology samples
begin
A% P% Q% SAMPLE
45.3 42.1 12.6 44W-7306
25.7 40.6 33.7 DA-1107
32.1 49.1 18.9 DA-1424

Note that a “begin” keyword appears in the file on the line before (above) the data column
headers. Although these data are already converted to ternary percentages, that is not necessary
because “Triangular” will always re-calculate values to ternary proportions. There must be one
label per data column, and there can be no embedded blanks in the label.

Below is a session with “Triangular”. Load this applications as you would any other application
(see instructions above for loading MAPPRO).

Command: triangular

====================================================================
     A C A D   T E R N A R Y   P L O T T I N G   P R O G R A M
                   by David Allison
                      Dept. of Earth Sciences
                      University of South Alabama
                      Mobile, AL 36688
                      E-mail: dallison@jaguar1.usouthal.edu
====================================================================
The default size of the Ternary base is 8.00 inches.
All parts of the diagram will be scaled relative to this value except
for plotted data points (if any).
Change the base length value (Y/N) [N]: n<ENTER>

The current x,y position of the lower left apex of the ternary diagram
is 1.50,0.75, change this (Y/N) [N]: n<ENTER>
All entities created will be plotted on the current layer
The current layer is:0
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Change current layer (Y/N) [N]:y<ENTER>

{Layer dialog window opens here, see Figure 2}

Plot ternary diagram border (Y/N) [Y]:n<ENTER>

Plot ternary plotting grid (Y/N) [N]:n<ENTER>

Plot data from file (Y/N) [Y]:y<ENTER>

begin
Below should be the names of the data column labels for the
selected file....
1: A%   2: P%   3: Q%   4: SAMPLE
If there is an error in the file, type <ESC> to end program,
otherwise, continue to the next prompt by typing any key...<ENTER>

NOTE:1st index(x)=lower left; 2nd(y)= lower right; 3rd(z)=upper apex.
Default x,y,z column indices are 1,2,3; change indices? (Y/N) [N]:n<ENTER>

Use a column to specify size of data symbol (Y/N) [N]:n<ENTER>

Use a column to specify block symbol name (Y/N) [N]:n<ENTER>

Use a column to specify data label (Y/N) [N]:y<ENTER>

Enter column number:4<ENTER>

Enter the default size of data symbols [0.069]: 0.075<ENTER>

The default data text label scale factor is 1.50
which would produce labels 0.11 units tall.
Change this value (Y/N) [N]:n<ENTER>

Enter the missing value flag [-99.000]: -99<ENTER>

Plot data headers as apex labels (Y/N) [Y]:n<ENTER>

{The application proceeds to plot data at this point}

The user should note that “Triangular “ can easily read a data file with many columns and use
any three as the data. The first column index is always plotted relative to the lower left apex,
second column index relative to the lower right apex, and the third column index relative to the
upper center apex. In this particular case, since the predefined template had “A” as the lower left,
“P” as the lower right, and “Q” as the upper middle apex, the first index should equal the “A”
column, the second index should be the “P” column, and the third index the “Q” column. Since
the data file contained only three numeric columns in A, P, Q order, the default indices of 1, 2,
and 3 is correct for this example. The fourth column contained the data point identifier. Figure 7
displays the final diagram with data plotted.
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Figure 1: Load application dialog in AutoCAD 2000.
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Figure 2: Layer dialog window.
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Figure 3: File create dialog used to save interactive point coordinates.
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Figure 4: File open dialog for selecting the structure data input file for
MAPPRO.
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Figure 5: Structure data posted into the 1:24,000 geologic quadrangle base map with
MAPPRO.
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Figure 6: Latitude and longitude grid constructed by LLGRID.
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Figure 7: Triangular diagram with IUGS A-P-Q apices and data plotted.


